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Chapter 1  

Introduction 

The Content Author’s Cookbook is designed to give content authors the information 
they need so that they can use Sitecore CMS to perform their day to day work. This 
cookbook is primarily aimed at introducing new content authors with limited computer 
skills to the tools that Sitecore contains. However, the procedures described in this 
document will also be beneficial for more experienced and technically skilled content 
authors who are unfamiliar with the tools that Sitecore contains. 

Content authors must be able to update existing content on their corporate Web site 
or intranet as well as create new material. This cookbook explains how to perform 
both these tasks with the two editing tools that Sitecore contains — the Page Editor 
and the Content Editor — and demonstrates how to edit existing items and create 
new items with both of these tools. The cookbook also introduces some of the more 
advanced features and functionality that Sitecore contains. 

This Content Author’s Cookbook contains the following chapters: 

 Chapter 1 — Introduction 
This chapter is a description of the content, aims and the intended audience of this 
manual.  

 Chapter 2 — Sitecore 
An introduction to some basic Sitecore functionality including item locking and 
formatting. 

 Chapter 3 — Managing Content in the Page Editor 
Step by step instructions for using the Page Editor to create and edit content. 

 Chapter 4— Managing Content in the Content Editor 
Step by step instructions for using the Content Editor to create and edit content. 

 Chapter 5 — The Rich Text Editor 
Step by step instructions for creating several versions of the same item as well as 
creating different language versions of the same item. 
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Chapter 2 Chapter 6 — Workflows for Content 

Editors 

This chapter describes workflows, what you can use them for, and how Sitecore uses 
them. There is also a description of the Workbox. 

 Workflows 

 The Workbox 
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2.1 Workflows 

Workflows are a system that you can use in Sitecore to control when an item is published. 

A workflow is a series of states that you define to reflect the work processes and procedures that you 
employ in your organization for creating Web content. These states can correspond to the creation, 
review, and approval stages that items must go through before they are published on your Web site. 

Workflows are a way of formalizing and enforcing these processes and procedures to ensure that only 
items that have been approved are published.  

A workflow can contain any number of different workflow states and be as simple or complex as 
required. Items do not necessarily have to pass through all the workflow states that you have defined 
— some states can be optional or only applicable for certain kinds of content. 

Furthermore, you can implement any number of different workflows. Each workflow must contain one 
workflow state that has been defined as the final workflow state. 

Items must pass through the appropriate workflow states and can only be published when they are in 
the final workflow state. 

2.1.1 Implementing Workflows 

Workflows are normally implemented by developers. It can however be useful for content authors to 
understand how they are constructed and implemented. 

Workflows consist of special items that are stored in the Sitecore content tree. 

A workflow consists of: 

A Workflow — the main item that contains all of the subitems that make up the workflow. 

Workflow States — the basic building blocks of the workflow. The workflow states represent the 
different stages in your content creation process. Items that are sent through a workflow start in the 
initial workflow state and in the final workflow state. 

Workflow Commands — the actions that must be performed by the various contributors to move the 
items from one workflow state to another. 

Workflow Actions — actions that are automatically performed on the items when they are in 
particular workflow states or when particular workflow commands are executed. 

Here is an example of a workflow: 

 

After the workflow has been defined, the developer specifies which item templates are subject to the 
workflow. When they have done this, every time a content author creates or edits an item that is 
based on one of these templates it is sent to the initial workflow state of this workflow.  



Sitecore CMS 6 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.  

Page 7 of 80 

Important 
Items can only be published when they are in the final workflow state. 

2.1.2 Using Workflows 

After the workflow has been implemented, content authors must send the items they create or edit 
through the workflow before they can be published. 

When you create a new item it is automatically placed in the initial workflow state. The item remains in 
this state until you use a workflow command to move it to another workflow state. 

If you edit an existing item that is subject to a workflow, Sitecore creates a new version of this item 
and places it in the initial workflow state. If you edit this item again later, you edit the version that is in 
the workflow unless you specifically that you want to edit another version. 

Important 
Items that are edited by administrators are not subject to workflows. 

Sending Items through Workflows 

When you have finished editing the item, you can send it to the next workflow state. 

To send an item to the next workflow state: 

1. In the Content Editor, open the item that you are working on. 

2. When you are satisfied that it can be send on through the workflow, click the Review tab. 

 

As you can see, the Workflow group displays a workflow command — Submit. This is the 
only workflow command that you can apply to the current item in its present workflow state.  

Furthermore, the item also displays a message informing you that this version of the item 
cannot be published because it is not in the final workflow state. 

3. Click Submit to send the item to the next workflow state. Sitecore displays a dialog box for 
you to enter a comment  

 

4. Enter a comment and then the item is moved to the next workflow state and the workflow 
commands that are available in the Workflow group change to reflect the items new status. 
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However, if you do not have permission to edit the item in this workflow state, you cannot lock 
the item for editing and the workflow commands will not be displayed. 

Sitecore also contains a Workbox that been designed for give reviewers a greater overview of all the 
items that are in workflows. 
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2.2 The Workbox 

The Workbox is a tool for reviewers and managers and gives them the overview they need to perform 
their tasks. 

Using the Workbox 

When you need to review content items, you should use the Workbox to see all the items that are 
currently in workflows and which workflow states they are in. 

To use the Workbox: 

1. Log in to the Sitecore Desktop. 

1. Click Sitecore, Workbox: 

 

In the Workbox, you can see that the Sample Workflow has been selected and you can see 
all the relevant workflow states. You can also see that there is one item in the Awaiting 
Approval workflow state. 

2. In the every workflow state, you can preview, open, compare, each item as well as apply the 
workflow commands that have been defined for that workflow state. In the Awaiting Approval 
workflow state, you can approve, or reject the item. 

Previewing an Item 

To preview the version of an item that is in a workflow state, click Preview and this version of the item 
is displayed in a new browser window.  

Opening an Item 

To open an item, click Open and the item is opened in the Content Editor. 
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Comparing an Item 

To see the changes that have been made to an item, click Diff.  

 

The Compare Versions dialog box lets you see the changes that have been made to this version of 
the item. You can select which versions to compare and whether you want them displayed in one or 
two columns 

Approving or Rejecting an Item 

When you are finished reviewing the item, click approve or reject to move the item to the appropriate 
workflow state. 

Several Workflows 

If you have implemented more than one workflow, you can view them at the same time or switch 
between the different workflows in the Workbox. 

 

To display or hide a workflow in the Workbox, select or clear the check boxes in the Workflows 
group. You can also expand and collapse each workflow and workflow state. 
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  
Customizing the Interface 
Step by step instructions for publishing content on your Web site.  
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Chapter 3  

Sitecore 

This chapter introduces some of the basic Sitecore functionality. This chapter 
explains how to log in, how item locking works, and describes how roles affect the 
functionality that is available to you in Sitecore CMS. 

This chapter contains the following section: 

 Logging In 

 Roles and Functionality 

 Item Locking 

 Formatting 
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3.1 Logging In  

You must log in to Sitecore before you can edit any of the content on a Web site. 

To log in to Sitecore: 

3. Enter Sitecore after the name of your Web site, for example 

http://www.mywebsite.net/sitecore and the Log in page appears: 

 

4. Select the task you want to perform, enter your user name and password and click Log in to 
log in and start editing the Web site. 
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Alternatively, click Advanced to open the Advanced Log In window.  

  

5.  Select the User Interface that you want to use, enter your user name and password, and click 
Log in to log in and start editing the Web site. 

Note 
In this manual, we use the Sitecore Training Sample Site as our demonstration site. 
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3.2 Roles and Functionality 

Sitecore contains tools that are suited to both experienced and inexperienced content authors. The 
Content Editor is the editing tool for experienced users. However, depending on the roles you have 
been assigned, the functionality that is available to you may differ from the functionality described in 
this guide. 

For example, a user who has been assigned one set of roles may see the following ribbon in the 
Content Editor: 

 

Whereas a user who has been assigned another set of roles may see much more functionality in the 
Content Editor ribbon: 

 

Furthermore, when you log in to the Sitecore Desktop, the set of applications shown in the Sitecore 
menu also depends on the roles that have been assigned to you. The following images show the 
Sitecore menu for two users who have been assigned a different set of roles: 
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3.3 Item Locking 

Sitecore uses item locking to ensure that two different users can’t edit the same item at the same 
time. If two or more users somehow managed to edit the same item simultaneously only the changes 
that have been made by the user who pressed Save last will be available. All the other changes will 
be lost.  

Item locking is a system whereby you lock the item you are editing and prevent other users from 
editing this item until you unlock it again after you have finished editing the item. 

Item locking works differently depending on the tools that you are using. 

 In the Page Editor, you can lock an item before you start to edit it. 

 In the Content Editor, you must lock an item before you can edit it. 

3.3.1 Item Locking in the Page Editor 

In the Page Editor, the way that item locking works depends on the access rights that you have been 
assigned. 

Minimal Page Editor 

If you only have access to the Minimal Page Editor, you do not have access to the ribbon and cannot 
manually lock an item before you edit it.  

In this case, Sitecore checks whether an item is locked or not when you save it. If the item is not 
locked your changes are saved. If the item has already been locked by another user, you receive a 
message informing you that the item has been locked by another user and your changes cannot be 
implemented. 

Limited or Full Page Editor 

If you have access to the Limited Page Editor or the Full Page Editor, you can edit an item directly on 
the page without locking it. When you save the item, Sitecore locks it for you. If the item has already 
been locked by another user, you receive a message informing you that the item has been locked by 
another user. 

Alternatively, you can click Lock or Edit to manually lock the current item before editing it.  

 

When an item has been locked by you, it is noted in the My Items command. 

 

In the previous image, the user has locked two items.  

When you have finished editing the item, you must remember to unlock it so that other users can edit 
it if they need to. 
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Unlocking Items 

You must remember to unlock items that you have locked.  

To unlock an item, select the item and click Edit or Lock 

If you have locked and edited numerous items, you can easily lose track of them all.  

To see which items are still locked by you, in the Edit group, click My Items: 

 

The My Items dialog box lists all of the items that you have locked.  

To unlock one or more items select them and click Unlock. To unlock all the items, click Unlock All.  
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3.4 Formatting 

In Sitecore, the formatting of the content that is displayed on a Web site is generally controlled by the 
style sheets that have been defined for the Web site by the administrators, designers, programmers, 
and so on. 

This means that as a content author you do not have to worry about how the material you are 
responsible for is presented to the reader and can concentrate on the quality of the material.  

You can of course influence the style by making some text bold or italic and so on. Furthermore if you 
know how to write HTML you can edit the code and thereby influence the way that the content is 
presented. But in general you can concentrate on the material that is presented and ignore the way 
that it is formatted. 
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Chapter 4  

Managing Content in the Page Editor 

This chapter introduces the Page Editor and the functionality it contains. It contains 
detailed descriptions of how to edit an existing item including how to edit simple text 
fields and rich text fields. There is a description of how to manage images in the Page 
Editor. There are also detailed instructions on how to create new items. 

This chapter contains the following sections: 

 The Page Editor 

 Editing an Item in the Page Editor 

 Creating a New Item in the Page Editor 

 Deleting Content 
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4.1 The Page Editor 

Content authors are generally focused on the quality and accuracy of the material displayed on the 
Web site and not on the design, style, and layout of the site. For this reason most content authors 
prefer to work in a program that is designed to meet their needs and not those of the developers and 
designers who create the Web sites. 

With this mind, Sitecore CMS allows content authors to edit and create items directly on the Web 
page with the Page Editor. The Page Editor is the simplest of the editing tools that Sitecore contains. 
It is designed for inexperienced content editors who edit and write content items directly on the page. 
It is a WYSIWYG editor (what you see is what you get) and limits the amount of functionality that is 
presented to the user. 

When you log in to the Page Editor, the functionality that is available to you can vary depending on 
the security roles that you have been assigned and the customizations that have been carried out on 
Web site you are accessing. 

When you log in to the Page Editor, two buttons are displayed at the top of the Web page: 

 

You can then navigate to the page that you want to edit and click Edit to open the Page Editor in edit 
mode. 

The functionality that you have access to in the Page Editor can vary greatly. As a minimum you can 
expect to see some buttons at the top of the Web page: 

 

If you have been given more access rights, you might be able to use a ribbon of commands. The 
ribbon you are presented with could look something like this: 

 

This ribbon contains all the functionality available in the previous screenshot plus a little more. 

When you are editing an item, you can click Ribbon to temporarily hide the ribbon and give yourself 
some more space to work with or have a less confusing layout. Click Ribbon again to display the 
ribbon. 
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If you have been given full access to the all the functionality contained in the Page Editor, you will be 
able to use all the commands in this ribbon: 

 

This ribbon consists of six tabs each with its own collection of commands. 
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4.2 Editing an Item in the Page Editor 

As mentioned earlier, the Page Editor is the simplest of the editing tools that Sitecore contains and 
has been designed for content editors who want to do their editing directly on the page.  

The Page Editor is a WYSIWYG editor that allows you to see the changes that you make directly on 
the page. This makes it easier for inexperienced users to control the changes that they make to the 
content items they are responsible for. 

In the Page Editor, you can edit: 

 Simple text fields, date fields, and so on —fields that you must edit on the page and have no 
extra functionality associated with them. 

 Rich text fields — fields that you must edit in the Rich Text Editor. 

 Media items — any kind of graphical item or sound file. 

Note 
In all of the procedures described in this manual, we use the Sitecore Training Sample Site as the 
demonstration Web site.  

4.2.1 Editing a Simple Text Field 

To edit a simple text field: 

1. Open the Starter Kit and log on to the Page Editor. 

2.  When the Page Editor opens it displays two buttons: 

 

3. Navigate to the item that you want to edit. 

4. Click Edit to start editing the item. 

5. In the item, select a simple text field that you want to edit.  

 

6. Edit the text directly on the page. The text field automatically expands to fit the text you enter.  

7. When you are finished editing the text, you can start editing another text block or click Save to 
save the changes, Save & Close to save the changes and exit editing mode, or Close to close 
the item and exit editing mode without saving the changes. 



Sitecore CMS 6 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.  

Page 23 of 80 

4.2.2 Editing a Rich Text Field 

A rich text field gives you more control over how the text appears on the Web page. 

To edit a rich text field: 

1. Select a rich text field and Sitecore displays some extra options. 

Depending on your installation, the options can vary from 

 to  

You can either edit the text directly on the page or in the Rich Text Editor. 

2. When you edit a rich text field directly on the page, you can not only edit the text but may also 
be able to format it. You make the text bold, italic and underlined. 

You can also insert a link or an image into the item 

Inserting a Link 

To insert a link into a rich text field: 

1. Click the link button  to open the Insert a Link dialog box. 

 

2. In the Insert a Link dialog box, expand the content tree and select the item that you want to 
create a link to. 

3. Click Link to create the link. 
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4. If the item that you want to link to is an image or media file, click the Media Items tab. 

 

5. Expand the content tree and select the media item that you want to link to. 

6. Click Link to create the link. 

Inserting an Image 

To insert an image into the rich text field you are editing: 

1. Click the Insert Image button  to open the Insert Media Item dialog box. 

 

2. Expand the content tree and select the image or media item that you want to insert. 

As you can see you can also insert other types of media into the item. These could be 
animations, film clips, sound files, and so on. 

3. Click Insert to insert the image into the rich text field.  

Uploading an Image or File 

If the media file, that you want to create a link to, is not available in the media library, you must upload 
it to the media library. 
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To upload an image or file to the media library: 

1. In the Page Editor, click the Insert Image button : 

 

2. In the Insert Media Item dialog box, click Upload to open the Upload a File dialog box: 

 

3. In the Upload a File dialog box, click Browse to locate the file you want to use. When you 
select the file, it is automatically uploaded to the Sitecore Media Library. 

When the media file is available in the Media Library, you can create a link to it or use it to illustrate 
your Web site. 

4.2.3 Editing a Rich Text Field in the Rich Text Editor 

You can also edit rich text fields in the Rich text Editor. 

1. Select the rich text field that you want to edit: 
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2. Click Edit Text to open the text in the Rich Text Editor: 

 

3. You can now edit the item in this window.  

The Rich Text Editor gives you access to more functionality. You can: 

 Insert and delete links to other parts of the Web site and to external Web sites. 

 Insert pictures or other media items. 

 Insert symbols into the text 

 Paste text from Microsoft Word into the item.  

If you prefer, you can use Microsoft Word to write the text you want to use in the item 
and paste it into the Rich Text Editor. 

 Find and replace text in the item. 

4. When you are finished editing the item in the Rich Text Editor, click Accept to save your 
changes. 

Furthermore, you can also view the item in HTML format, if you have the necessary expertise and feel 
comfortable editing the text in that format.  

Note 
The functionality that is available in the Rich Text Editor is controlled by your Sitecore system 
administrator. If you need more functionality, ask your administrator to make it available to you. 

For more information about using the Rich Text Editor, see Chapter 6 ‘The Rich Text Editor.’ 

4.2.4 Editing a Graphical Item 

You can also use the Page Editor to edit any graphic items that are displayed on the Web site. When 
you select an image, you are presented with some additional options:  
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You can: 

 Edit the link that the image contains – if there is one. 

 Select the image to be displayed. 

 Edit the properties of the image. 

Once again, the options that are available to you can vary from installation to installation. 

Editing the Link 

To edit the link: 

1. If the picture is a link, click Edit Link: 

 

2. In the left-hand pane of the Internal Link dialog box, select the item that the link should open.  

You can only link to another item in this Web site and cannot link to another Web site. 

3. The Internal Link dialog box contains the following fields: 
 

Field Value 

Link Description A description of the link. 

Anchor The name of the anchor on the page you want to link to. 
The browser will scroll directly to this point on the page. 

Target Window Whether the link should use the same browser window, 
another browser window or a custom window. 

Custom If you select Custom in the target Window field, you specify 
the custom window here. 

Style Class The style class that you want to use. 

Alternate Text An alternative text that will be displayed when you move the 
mouse over the image. 

Query String A query that will be added to the link. 

4. Fill the fields in with the appropriate information. 

Changing the Image 

To change the image that is displayed in the rich text field: 

1. In the Page Editor, select the image that you want to change.  
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2. Click Choose Image to open the Media Browser dialog box: 

 

The Media Browser dialog box lets view all of the items that are currently available in the 
Sitecore Media Library. 

3. Select the image that you want to use and click OK. 

This new image is inserted into the current item. 

4. In the Page Editor, click Save to save the changes, Save & Close to save the changes and 
exit edit mode, or Close to close the item and exit edit mode without saving the changes. 

Editing the Properties of an Image 

To edit the properties of the image: 

1. Click Image Properties to open the Image Properties dialog box. 

 

2. In the Alternate Text field, enter the text to be displayed when you move the mouse over the 
image. 

3. In the Dimensions section, specify the dimensions that the image should be displayed in — if 
they differ from the actual size of the image. 

4. In the Space section, specify how much space should be placed around the image. 
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4.3 Creating a New Item in the Page Editor 

As a content author, you not only have to edit content but also create new content items and insert 
them into the Web page where you want them displayed. 

The ways in which you can create items in Sitecore can vary depending on the security roles that you 
have been assigned and the way your Web site has been customized. 

4.3.1 Inserting Items  

When you log on to the Page Editor, you should navigate to the page that you want to edit. When you 
click the Edit button at the top of the page, you are presented with all of the editing tools that are 
available to you on this Web site. 

To insert a new item onto the page: 

1. Click Insert to open the Insert dialog box. 

 

The type of item that you can create will vary depending on where you are on the Web site. If 
you are on the front page, you can insert a new section and depending on the type of section 
you are on, you can add appropriate items to that section. 

2. Select the type of item that you want to insert. In this example, you insert a new section. 

3. In the Item Name field, enter the name of the section that you want to insert. 
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4. Click Insert to create the new section and a section is added to the Web site: 

 

As you can see the new section contains no items and the sidebar contains the same text as 
the Home page. 

When you create a new item it is automatically locked to prevent other users from editing it. 

5. To add an item to the Products section, click Insert and the Insert dialog box contains the 
following options: 

 

6. Select the item that you want to create. 

7.  In the Item Name field, enter the name of the new item and click insert. 
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These items have different designs and allow you to present different information on the Web 
page. 

 

Both the items you can select and the presentation possibilities that they give you are 
determined by the design and style that has been implemented on your particular Web site. 

8. You should now edit the items and the section you have inserted and add text, images, 
sidebar text, and so on. 

When you are finished editing the new items, you must unlock them. 

To unlock the items: 

1. In the Edit group, click My Items to see a list of all the items you have locked. 

 

2. In the My Items dialog box, select the items that you have finished editing and click Unlock to 
unlock the item. If you have finished editing all the items, click Unlock All to unlock all the 
items. 
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4.4 Deleting Content 

Content authors must delete items and content from time to time. This is a very simple task in the 
Sitecore Page Editor. 

4.4.1 Deleting an Item 

To delete an item from the Web site: 

1. Navigate to the item that you want to delete. 

If you want to delete an item, navigate to that item. 

If you want to delete a sub-item, navigate to the sub-item in question and not just the link to it 
that is shown on another item. 

2. Click Delete to remove the item or section. 

Once again depending on the customizations carried out on your Web site and the way the 
Page Editor has been configured, the Delete button may be located on the ribbon or at the top 
of the screen. 

3. If you try to delete an item that contains sub-items, a message will appear informing you that 
that the section contains sub-items and that these items will be deleted along with the section.  

 

If you want to save any of the items, you must move them to another section. 

4. Click OK to delete the item and its subitems. 
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Chapter 5  

Managing Content in the Content Editor 

This chapter introduces the Content Editor and the functionality it contains. It contains 
detailed descriptions of how to edit existing items. There is also a description of how 
to manage images in the Content Editor. There are detailed instructions on how to 
create new items and how to delete items. 

This chapter contains the following sections: 

 The Content Editor 

 Editing an Item in the Content Editor 

 Creating New Items in the Content Editor 

 Deleting Items in the Content Editor 
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5.1 The Content Editor 

The Content Editor has been designed for more experienced content authors who feel comfortable 
working with a computer, Microsoft Word, and are familiar with Sitecore and the functionality that it 
contains. 

The Content Editor is a large application but its appearance and the functionality that it contains 
varies depending on the roles that have been assigned to the user, the local security settings and the 
amount of customizations that have been carried out on your installation. 

The Content Editor gives the user access to an array of functionality that meets the needs of the more 
experienced content author.  

The functionality that you have access to in the Content Editor can vary greatly. As a minimum you 
can expect to see: 

 

If you have been given more extensive access rights, you will probably have access to more 
commands and more tabs: 

 

If you have complete access to the Content Editor, it will look something like this: 

 

5.1.1 The Page Editor vs. the Content Editor 

When you log in to the Content Editor, the items that make up your Web site are presented to you in a 
very different way that they are in the Page Editor. In the Page Editor, you see the items as they are 
presented on the Web site. In the Content Editor, you see the items as objects in the content tree and 
when you select an item it is presented to you as a list of fields that you can edit. 
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For example, the Products section of the Sample Web site looks like this in the Page Editor: 

 

You can edit all of the items that appear on the page — text, graphics, logos, links, and so on. 

When you open the Products section in the Content Editor, it looks like this: 

 

As you can see, it is presented as a list of fields that you can edit. Furthermore, the fields you are 
presented with are only those that belong to the Products item itself. The Sitecore logo, the Home 
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Products item, and so on are all separate items and must be edited independently of each other in the 
Content Editor. 

5.1.2 The Content Tree 

One of the main features of the Content Editor is the content tree that it uses to present all the items 
that have been created for the Web site. 

 

The Sitecore content tree has a similar tree structure to the one used in Windows Explorer. In 
Sitecore objects and groups are not represented by standard folder and file icons but by many 
different icons. You can expand and open every group in the Sitecore content tree just as you can the 
folders in Windows Explorer. When there is a plus ‘+’ beside an icon, it contains sub items and can be 
expanded. When there is a minus ‘-’ beside an icon, it has already been expanded and when there is 
no symbol, the item contains no sub items. 

Searching in the Content Tree 

There is a search function associated with the Sitecore content tree. This helps you find items quickly 
and can be particularly useful in very large Web sites and in sites that you are unfamiliar with. 

To search for an object: 

1. In the Content Tree, select the object that you want to search from. This is the starting point 
for your search. 

The Sitecore search engine searches the entire content tree. However, the search results list 
the items that are found after this starting point above the items that are found before this 
starting point. 

The Sitecore search engine does not support wildcards. 
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2. In the Search field, enter the value that you want to search for. This can be any character, 
number, word, and so on. 

 

3. Click the Search button  or press ENTER to perform the search and the results are 
displayed. 

 

Adding an Extra Criteria 

Sometimes you might need to refine your search by entering extra criteria. 

To add extra criteria to your search: 

1. Click the drop-down arrow  to open an extra pane: 

 

2. If you want to search for an object by its name, enter the value in the Name field. 

Starting point for the search 

Folder the item is stored in 
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3. To change the field that you search in, click the name of the field and a list appears displaying 
the names of all the fields in the current item. 

 

4. To add an extra criterion, in the Add Criteria field, enter the name of the criteria. 

 

5. Click Add Criteria to add the new criterion to the list. 

6. You can then click the name of the new criteria and select a field name from the list that 
appears. 

The results of the search are displayed in the Search Results pane. The items that were 
found below the current item are displayed first. 

Removing the Extra Criteria 

To remove the extra criterion, click the criterion you want to remove and then click Remove at the 
bottom of the menu that appears. 

5.1.3 Locking in the Content Editor 

In the Content Editor, you must lock an item before you can edit it.  

Locking an Item 

To lock an item: 

1. In the Content Editor, navigate to the item that you want to edit. 



Sitecore CMS 6 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.  

Page 39 of 80 

2. On the Home tab, click Edit to lock the item. 

 

3. When you lock the item, the functions and commands that are available to you are activated 
in the Content pane. 

 

4. You can now start editing the item. 

Unlocking an Item 

When you have finished editing the item, you must remember not only to save the changes but also to 
unlock the item so that others users can edit it. 

To unlock the current item, click Edit. 

As a content author, you often have to make extensive changes to many items on the Web site. This 
can mean that you have to lock many items and keep them locked to ensure that your changes are 
implemented consistently across all the items. 

Sitecore keeps track of all the items that are locked to ensure that nobody else can edit them but it 
also keeps track of all the items that have been locked by each individual user.  
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To unlock the items you have locked: 

1. In the Content Editor, click the Review tab. 

 

2. In the Locks group, click My items: 

 

The My Items dialog box lists all of the items you have locked. You can have locked these 
items during the current session or during previous sessions. 

3. Select the items that you are finished editing and click Unlock to unlock them or click Unlock 
All to unlock all the items. 

 

 



Sitecore CMS 6 Content Author's Reference and Cookbook   

 

Sitecore® is a registered trademark. All other brand and product names are the property of their respective holders. The 
contents of this document are the property of Sitecore. Copyright © 2001-2011 Sitecore. All rights reserved.  

Page 41 of 80 

5.2 Editing an Item in the Content Editor 

As mentioned earlier, experienced content authors feel more at home with the advanced functionality 
that is available in the Sitecore Content Editor. 

Note 
You must lock an item before you can edit it in the Content Editor. 

In all the procedures and tasks described in this chapter, it is assumed that you have already locked 
the item.  

5.2.1 Working with Text  

After you have selected an item in the content tree, you can edit it. 

To edit an item in the Content Editor: 

1. In the Content Editor, locate the item that you want to edit in the content tree. 

 

2. In the Content pane, locate the field that you want to edit. 
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3. If you want to edit a single line or multiple line text field, you can do it directly in the field: 

 

4. When you want to edit a rich text field, you cannot edit it directly in the field:  

 

5. Click Show Editor to open the Rich Text Editor: 

 

The Rich Text Editor gives you access to more functionality. You can: 

 Insert and delete links to other parts of the Web site and to external Web sites. 

 Insert pictures or other media items. 

 Insert symbols into the text 

 Paste text from Microsoft Word into the item.  

If you prefer, you can use Microsoft Word to write the text you want to use in the item and 
paste it into the Rich Text Editor. 
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 Find and replace text in the item. 

Note 
The functionality that is available in the Rich Text Editor is controlled by your Sitecore system 
administrator. If you need more functionality, ask your administrator to make it available to 
you. 

Furthermore, you can also view the item in HTML format, if you have the necessary expertise 
and feel comfortable editing the text in that format.  

6. When you are finished editing the item in the Rich Text Editor, click Accept to save the 
changes you have made to the field. 

7. In the Content Editor, scroll down through the item and expand all of the bands and check 
that all of the fields contain the right content. For example does the sidebar contain the 
appropriate text? 

 

8. Click the Review tab and in the Proofing group, click Spelling to start the spell checker. The 
spell checker runs through all the text fields in the item. 

9. When you have finished editing the item, click Save to save the changes you have made to 
the item and then click Edit to unlock the item so that other users can edit it if they need to. 

Note 
The spell checker only checks the current item. If you have edited several items, you must open them 
individually and run the spell checker. 

For more information about using the Rich Text Editor, see Chapter 6 ‘The Rich Text Editor.’ 

5.2.2 Working with Graphics 

As a content editor, you will often have to change or edit the media items that are displayed on your 
Web site.  
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Changing an Image 

To change an image: 

1. In the Content Editor, locate the item that you want to edit in the content tree. 

 

2. In the Content pane, click Browse to open the Media Browser dialog box: 

 

When the Media Browser opens, it displays the image that is already shown in the item you 
are editing. 

3. Locate the image that you want to use, select it and click OK.  
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4. The image you selected is now used in the item you are editing. 

 

Uploading an Image 

If the image you want to use is not available in the Media Library, you can easily make it available by 
uploading it to the Media Library. 

To add an image to the Media Library: 

1. In the Content pane, click Browse to open the Media Browser dialog box. 

2. In the Media Browser dialog box, click Upload: 

 

3. In the Upload a File dialog box, click Browse and navigate to the image that you want to add 
to the Media Library. 

The image is automatically uploaded to the Media Library and you can now use it on your 
Web site. 

Editing the Properties of an Image 

After you have added an image to an item in the Content Editor, you can edit the properties of the 
image. 
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To edit the properties of the image: 

1. In the Content pane, scroll to the field containing the image. 

 

2. Click Properties to open the Image Properties dialog box: 

 

3. In the Alternate Text field, enter the text that you want to be displayed when you move the 
mouse over the image. 

4. In the Dimensions section, specify the dimensions that the image should be displayed in — if 
they differ from the actual size of the image. 

5. In the Space section, specify how much space should be placed around the image. 

Editing an Image 

You can also use Sitecore to edit the image if you need to.  
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To edit an image: 

1.  Scroll to the field that contains the image. 

 

2. Click Edit Image to open the image in the Image Editor: 

 

3. In the Image Editor, you can crop, resize, flip and rotate the image. 

If you need to do more to the image, you should use a proper image editor such as 
Photoshop or Paint Shop Pro and then upload the image to the Media Library again. 

4. When you are finished editing the image, click Save and close the Image Editor to return to 
the Content Editor. 

All the changes that you make are applied to the version of the image that is stored in the 
Media Library and not just the copy shown on your Web page. 

5. In the Content Editor, click Refresh to see the changes that you made. 

6. If you want to remove the image, click Clear. 
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5.3 Creating New Items in the Content Editor 

There are several ways to create new items in the Content Editor. 

You can: 

 Create a new item 

 Duplicate an existing item 

 Copy an item to another location.  

 Create an item based on a template. 

In the Content Editor, when you insert a new item, it is generally created as a sub item of the current 
item. However, you can also create a new item at the same level as the current item. You cannot 
create an item that is at a higher level than the current item. 

The following sections describe how to use the Sitecore ribbon to create, copy, move, duplicate and 
delete items. You can also access all of this functionality by right-clicking in the content tree. 

 

5.3.1 Creating a New Item 

You can easily create a new item as a subitem of the current item. 

Inserting a Sub-Item 

To insert a new sub-item: 

1. In the Content Editor, locate the item for which you want to create a new sub-item. 
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2. In the Insert group, click one of the item types that is displayed: 

 

3. If the item type you want to insert is not displayed, click the scroll arrows in the Insert group 
to find the type of item you want. 

Alternatively, in the Insert group, click the drop-down arrow  and select the subitem from 
the list that appears: 

 

4. In this drop down list, you can select a subitem or a sibling. A sibling is an item on the same 
level as the current item. 

To insert an item at the same level as the current item, in the Insert a New Sibling section, 
click Site Section  

In this example, we add a new product category to the list. This new category is a subitem of 
Products and can contain its own subitems. 

5. Select the type of subitem that you want to create and a dialog box appears prompting you to 
name the new item: 

 

6. Enter a name for the new item. 
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The new item is now added to your Web site.  

 

As you can see, the new item has been created as a subitem of products and has been 
automatically locked. 

Every new item that you create is automatically locked and opened for you. You must unlock 
them before other users are allowed to edit them. 

7. Edit the new item. Scroll down through the fields and add an image, text, and so on. 

When you have finished editing the item, you can add a new subitem to it. 

5.3.2 Duplicating an Existing Item 

Sitecore lets you duplicate existing items.   

To duplicate an existing item: 

1. In the content tree, locate the item that you want to duplicate. 

In this example, we will duplicate the Wash-o-matic product and then move it to the new 
product category that we just created. 

2. On the Home tab, in the Operations group, click Duplicate and a dialog box appears 
prompting you to name the new item. 

3. Enter a name for the new item and it is added to the content tree: 

 

As you can see, the new item has been added at the same level as the item you duplicated. It 
also contains all of the same text, images, and so on as the original item. 

4. Edit the new item and enter the text, images, and so on that you want to be displayed in this 
item. 

When you have finished editing the item, you can move it to the correct location. 
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Moving an Item 

To move an item: 

1. In the content tree, locate the item that you want to move. 

2. On the Home tab, in the Operations group, click Move To. 

 

3. In the Move Item To dialog box, select the location that you want to move the item to. 

4. Click Move to move the item to the new location. 

 

5.3.3 Copying an Item to another Location 

You can also create a new item by copying an existing item to the location where you want the new 
item to belong. 

To copy an item to another location: 

1. In the content tree, locate the item that you want to copy. 
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2. On the Home tab, in the Operations group, click Move To. 

 

3. In the Copy Item To dialog box, select the location that you want to copy the item to. 

4. Click Copy and the item is copied to the specified location.  

 

5. Edit the new item. 

6. On the Home tab, in the Rename group, click Rename: 

 

7. Enter the new name of the item. 

5.3.4 Creating an Item Based on a Template 

If you have been given sufficient access rights, you can also create an item based on a template. 
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To create an item based on a template: 

1. In the content tree, locate the item that you want to create a subitem for. 

2. On the Home tab, in the Insert group click the scroll arrow  and select Insert from 
Template. 

 

3. In the Insert from Template dialog box, select the template that you want to use to create the 
new item. 

4. In the Item Name field, enter a name for the new item. 

5. Click Insert and the item is added to the content tree. 

 

6. Edit the item. 

7. Save your changes. 
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Previewing Your Changes 

When you have finished editing all the new items that you have created you might like to see how 
these new items will look on your Web site.  

To see a preview of your changes: 

1. Click the Publish tab. 

2. In the Publish group, click Preview to see how the item looks. 

 

A new browser window opens displaying the current item. You can then browse the Web site 
to see all the changes that have been made. 

The following changes have been made to the sample site: 

 The Novelty Products category has been added to the product category list. The Products 
page contains a Novelty Products entry. 

 The novelty items, Clown Shoes, and so on, have been created in the novelty products 
category. The Novelty Products page lists all of the products that we created items for. 

 Each of the products that you created has its own page in the Web site. 

When you are satisfied with all the changes that you have made, unlock all the items that have been 
locked during this session. 
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5.4 Deleting Items in the Content Editor 

Content authors must delete items and content from time to time. This is a simple task in the Content 
Editor. 

5.4.1 Deleting an Item 

To delete an item from the Web site: 

1. In the content tree, locate the item that you want to delete. 

2. On the Home tab, in the Operations group, click Delete. 

Alternatively, you can right-click the item in the content tree and click Delete in the shortcut 
menu that appears. 

The item is deleted from the Web site. 

3. If you try to delete an item that contains sub-items, a message will appear informing you that 
that the section contains sub-items and that these items will be deleted along with the main 
item. 

 

If you want to save any of the items, you must move them to another part of the Web site. 

4. Click OK to delete the item and its subitems. 
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Chapter 6  

The Rich Text Editor 

The Rich Text Editor is the word processing tool that Sitecore uses. This chapter 
explains some of the functionality that it contains. The topics described in this chapter 
include inserting, removing and managing links. 

This chapter contains the following sections: 

 Using the Rich Text Editor 
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6.1 Using the Rich Text Editor 

When you are editing a rich text field in the Page Editor or in the Content Editor, you must use the 
Rich Text Editor. This is a standard word processing tool but in Sitecore we have removed most of the 
formatting functionality because the format of the items that content authors create and edit is 
determined by the style sheets and templates that have been implemented for your Web site. 

However, if you need access to more functionality in the Rich Text Editor, you should contact your 
system administrator and they can make it available to you. 

6.1.1 Editing Text 

When you open the Rich Text Editor, the text in the field you are editing is displayed: 

 

You can now edit the text and use the functionality that is available.  

Pasting Content from Word 

As a content author, you might feel more comfortable writing your content in Word. When you are 
satisfied with the material, you can paste it into the Rich Text Editor. 

To paste content from Word: 

1. Select and copy all the text in Word that you want to paste into a rich text field in Sitecore. 

2. In Sitecore, open the Rich Text Editor.  

3. Click the Paste from Word button  and the text is pasted into the Rich Text Editor. 

When the text is pasted in all of the information about fonts, sizes, formatting, and so on is 
removed.  

However, if you have created a table in Word, it is pasted in and you must reformat it in the 
Rich Text Editor. 

6.1.2 Inserting, Removing, and Managing Links 

As a content author, you will have to manage links in your content. The Rich Text Editor allows you to 
insert, remove and edit the links in your content. 

Inserting an Internal Link 

An internal link is a link to another item on your own Web site. 
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To add an internal link: 

1. In the Rich Text Editor, select the image or text that you want to be a link. 

2. Click the Insert Sitecore Link button . 

 

3. In the Insert a Link dialog box, in the Internal Link tab, expand the content tree and select 
the item that you want to create a link to. 

4. Click Link to create the link. 

5. If the item you want to create a link to is an image or media file, click the Media Items tab. 

 

6. Expand the content tree and select the media item that you want to link to. 

7. Click Link to create the link. 

Inserting an External Link 

An external link is a link to another Web site. 

To insert an external link: 

1. In the Rich Text Editor, select the image or text that you want to be a link. 
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2. Click the Hyperlink Manager button . 

 

3. In the Hyperlink Manager dialog box, enter the information about the Web site you want to 
link to. 
 

Field Value 

URL The URL of the Web site. 

Existing Anchor Whether there is an anchor already. 

Link Text The text in the link. You can edit this text here. 

Type The type of link you want to create. 

Target The window that the link should open. 

Tooltip  A tooltip that is displayed when you move the mouse over 
the link. 

CSS Class The style sheet that the link should use.  

Managing Hyperlinks 

You can also use the Hyperlink Manager dialog box to edit existing links, create anchors and create 
e-mail links.  

An anchor is an HTML code that is used to create a link to another page or to a particular section 
within a page. 

To create an anchor: 

1. In the Rich Text Editor, select the image or text that you want to be an anchor. 

2. Click the Hyperlink Manager button . 

3. In the Hyperlink Manager dialog box, click the Anchor tab. 

 

4. In the Name field, enter the name of the anchor. 
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5. You can now create a link to this anchor by selecting it in the Hyperlink Manager dialog box. 

 

You can also use the Hyperlink Manager to create e-mail links. An e-mail link opens a new mail in 
the program you use to send e-mail, for example, Outlook. The e-mail will be sent to the e-mail 
address specified in the e-mail link. 

To create an e-mail link: 

1. In the Rich Text Editor, select the image or text that you want to be the link. 

2. Click the Hyperlink Manager button . 

3. In the Hyperlink Manager dialog box, click the E-mail tab. 

 

4. In the Address field, enter the e-mail address that the mail should be sent to. 

5. In the Subject field, enter the text that you want to appear in the Subject field in the e-mail. 

Removing a Link 

To remove a link, in the Rich Text Editor, select the link and click the Remove Link button . The 
link is removed and the text becomes ordinary text. 

Note 
You can use the Hyperlink Manager to edit any links that exist on your Web site. 
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Chapter 7  

Workflows for Content Editors 

This chapter describes workflows, what you can use them for, and how Sitecore uses 
them. There is also a description of the Workbox. 

 Workflows 

 The Workbox 
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7.1 Workflows 

Workflows are a system that you can use in Sitecore to control when an item is published. 

A workflow is a series of states that you define to reflect the work processes and procedures that you 
employ in your organization for creating Web content. These states can correspond to the creation, 
review, and approval stages that items must go through before they are published on your Web site. 

Workflows are a way of formalizing and enforcing these processes and procedures to ensure that only 
items that have been approved are published.  

A workflow can contain any number of different workflow states and be as simple or complex as 
required. Items do not necessarily have to pass through all the workflow states that you have defined 
— some states can be optional or only applicable for certain kinds of content. 

Furthermore, you can implement any number of different workflows. Each workflow must contain one 
workflow state that has been defined as the final workflow state. 

Items must pass through the appropriate workflow states and can only be published when they are in 
the final workflow state. 

7.1.1 Implementing Workflows 

Workflows are normally implemented by developers. It can however be useful for content authors to 
understand how they are constructed and implemented. 

Workflows consist of special items that are stored in the Sitecore content tree. 

A workflow consists of: 

A Workflow — the main item that contains all of the subitems that make up the workflow. 

Workflow States — the basic building blocks of the workflow. The workflow states represent the 
different stages in your content creation process. Items that are sent through a workflow start in the 
initial workflow state and in the final workflow state. 

Workflow Commands — the actions that must be performed by the various contributors to move the 
items from one workflow state to another. 

Workflow Actions — actions that are automatically performed on the items when they are in 
particular workflow states or when particular workflow commands are executed. 

Here is an example of a workflow: 

 

After the workflow has been defined, the developer specifies which item templates are subject to the 
workflow. When they have done this, every time a content author creates or edits an item that is 
based on one of these templates it is sent to the initial workflow state of this workflow.  
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Important 
Items can only be published when they are in the final workflow state. 

7.1.2 Using Workflows 

After the workflow has been implemented, content authors must send the items they create or edit 
through the workflow before they can be published. 

When you create a new item it is automatically placed in the initial workflow state. The item remains in 
this state until you use a workflow command to move it to another workflow state. 

If you edit an existing item that is subject to a workflow, Sitecore creates a new version of this item 
and places it in the initial workflow state. If you edit this item again later, you edit the version that is in 
the workflow unless you specifically that you want to edit another version. 

Important 
Items that are edited by administrators are not subject to workflows. 

Sending Items through Workflows 

When you have finished editing the item, you can send it to the next workflow state. 

To send an item to the next workflow state: 

6. In the Content Editor, open the item that you are working on. 

7. When you are satisfied that it can be send on through the workflow, click the Review tab. 

 

As you can see, the Workflow group displays a workflow command — Submit. This is the 
only workflow command that you can apply to the current item in its present workflow state.  

Furthermore, the item also displays a message informing you that this version of the item 
cannot be published because it is not in the final workflow state. 

8. Click Submit to send the item to the next workflow state. Sitecore displays a dialog box for 
you to enter a comment  

 

9. Enter a comment and then the item is moved to the next workflow state and the workflow 
commands that are available in the Workflow group change to reflect the items new status. 
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However, if you do not have permission to edit the item in this workflow state, you cannot lock 
the item for editing and the workflow commands will not be displayed. 

Sitecore also contains a Workbox that been designed for give reviewers a greater overview of all the 
items that are in workflows. 
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7.2 The Workbox 

The Workbox is a tool for reviewers and managers and gives them the overview they need to perform 
their tasks. 

Using the Workbox 

When you need to review content items, you should use the Workbox to see all the items that are 
currently in workflows and which workflow states they are in. 

To use the Workbox: 

10. Log in to the Sitecore Desktop. 

11. Click Sitecore, Workbox: 

 

In the Workbox, you can see that the Sample Workflow has been selected and you can see 
all the relevant workflow states. You can also see that there is one item in the Awaiting 
Approval workflow state. 

12. In the every workflow state, you can preview, open, compare, each item as well as apply the 
workflow commands that have been defined for that workflow state. In the Awaiting Approval 
workflow state, you can approve, or reject the item. 

Previewing an Item 

To preview the version of an item that is in a workflow state, click Preview and this version of the item 
is displayed in a new browser window.  

Opening an Item 

To open an item, click Open and the item is opened in the Content Editor. 
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Comparing an Item 

To see the changes that have been made to an item, click Diff.  

 

The Compare Versions dialog box lets you see the changes that have been made to this version of 
the item. You can select which versions to compare and whether you want them displayed in one or 
two columns 

Approving or Rejecting an Item 

When you are finished reviewing the item, click approve or reject to move the item to the appropriate 
workflow state. 

Several Workflows 

If you have implemented more than one workflow, you can view them at the same time or switch 
between the different workflows in the Workbox. 

 

To display or hide a workflow in the Workbox, select or clear the check boxes in the Workflows 
group. You can also expand and collapse each workflow and workflow state. 
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Chapter 8  

Customizing the Interface 

You can change the interface in Sitecore. This chapter describes how to increase 
usable screen space, customize the interface in the Content Editor and in the Page 
Editor. There is also a description of how to customize the Sitecore Desktop. 

This chapter contains the following sections: 

 Working with the Browser 

 Customizing the Content Editor 

 Customizing the Page Editor 
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8.1 Working with the Browser 

All of the interfaces and programs that Sitecore contains are displayed in a normal Web browser.  

8.1.1 Full Screen Mode 

If you need to see more of the Web page or item that you are editing because there are too many 
elements in the way or because you are using a computer with a small screen, you can gain some 
space by expanding the browser interface to full screen mode. 

To enable full screen mode, press F11. This expands the browser window to fill the entire screen and 
hides the user interface elements of the browser — the title bar, menus, toolbar and status bar. 

To see some of hidden user interface elements, move your mouse to the top of the screen. Press F11 
again to restore the hidden browser user interface elements and exit full screen mode. 

8.1.2 The Sitecore Desktop 

When you are using the Sitecore Desktop application you can change some of the settings that affect 
the way Sitecore looks and customize other settings to suit your needs. 

In the Sitecore Desktop, you can: 

 Change the desktop background. 

 Change your password. 

 Change the application options. 

 Change your personal information. 

 Change the language settings. 

Changing the Desktop Background 

You can change the image displayed as your desktop background when you log in to the Sitecore 
desktop. 

To change the desktop background: 

1. Log in to the Desktop. 

2. Click the Sitecore menu and then click Control Panel, Preferences: 
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3. In the Preferences dialog box, click Change Your Desktop Background. 

 

4. In the Background field, select the image that you want to use. 

5. In the Position field, use the drop down arrow to select how you want to place the image on 
the desktop. 

6. In the Color field, select the color you want to surround the image if it does not fill the screen. 

Changing Your Password 

To change your password: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 

2. In the Preferences dialog box, click Change Your Password. 

 

3. In the Change Password dialog box, enter your current password and then enter and confirm 
your new password. 
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You can also change your password in the Sitecore log in page. 

 

Changing your Personal Information 

To change your personal information: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 

2. In the Preferences dialog box, click Change Your Personal Information. 

 

3. In the Personal Information dialog box, you can change your name, e-mail address, and the 
image that is used as your portrait throughout Sitecore. 

Changing Your Regional and Language Options 

To change your regional and language options: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 
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2. In the Preferences dialog box, click Set Your Regional and Language Options. 

 

3. In the Regional and Language Settings dialog box, you can: 

o Select the formats that you want to use for numbers, currencies, times, and dates. 

o Select the language that you want the client application to use. 

Using the Default Settings 

To use the default settings: 

1. In the Sitecore Desktop, click the Sitecore menu and then click Control Panel, Preferences. 

2. In the Preferences dialog box, click Reset My Settings to Default values. 
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8.2 Customizing the Content Editor 

The Content Editor contains a variety of user interface elements that you can customize to suit your 
needs. 

You can, for example, give yourself more room to work in by: 

 Customizing the ribbon. 

 Customizing the content tree. 

 Resizing the editing pane. 

8.2.1 Customizing the Ribbon 

There are several ways in which you can customize the ribbon. 

You can: 

 Hide the ribbon. 

 Hide the tabs. 

 Create your own toolbar 

Hiding the Ribbon 

To hide the ribbon in the Content Editor:  

1. Double-click any tab to hide the ribbon. 

 

The ribbon is removed but the tabs are still displayed. 

2. Click on a tab to open that tab and display the ribbon again. 

Hiding Tabs 

You can also specify which tabs are displayed in the Content Editor. 

To hide a tab: 

1. Right-click anywhere on the ribbon to open a dialog box: 

 

2. Select or clear the check boxes to decide which tabs you want displayed in Content Editor. 
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3. Click reset to restore the default tab selection. 

Creating your own Toolbar 

You can also create your own toolbar that only contains the tools and functionality that you need to do 
your work. 

To create your own toolbar: 

1. Right-click anywhere on the ribbon and click Customize to open the Customize My Toolbar 
dialog box. 

 

1. In the All pane, expand the groups and select the commands that you want on your toolbar. 

You can only select commands and not groups. You can however insert separators to divide 
them into groups and use the up and down arrows to place the commands in the order you 
want. 

 

2. When you are finished, click OK. 
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3. Right-click on the ribbon to open the tabs dialog box and select the My Toolbar tab. The tab 
is added to the ribbon and contains all the command that you just selected. 

 

8.2.2 Customizing the Content Tree 

In the Content Editor, you can easily resize the content tree pane or hide the content tree entirely if 
you prefer. 

Hiding the Content Tree 

To hide the content tree: 

1. In the Content Editor, click the View tab. 

 

2. Clear the Content Tree check box to hide the content tree. 

3. Clear the Entire Tree check box to hide the root of the content tree (sitecore) and the media 
library. This view ensures that users can only see the items that are part of their Web site. 

4. Clear the Hidden Items check box to hide some of the system items that are displayed in the 
content tree. 

The other two settings — Raw Values and Standard Fields are only relevant for 
administrators. 

Resizing the Content Tree 

You can also resize the content tree. This can be useful when you need to find an item or when the 
pane takes up too much space. 

To resize the content tree: 

1. In the Content Editor, move the mouse over the bar between the Content Tree and the 
Editing pane. 

2. Drag the bar to the left or right to resize the elements in the window. 
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Configuring the Quick Action Bar 

The Quick Action Bar runs down the side of the content tree and can be used to display information 
that can be useful to both the content author and the administrator. 

 

To configure the Quick Action Bar 

1. Right-click the Quick Action Bar to see a list of the elements that it can display. 

 

2. Click an item in the menu to hide or display an icon beside the item that is affected.  

You can select the following items: 
 

Menu Item Tells you 

My Locked Items Which items you have locked. 

Locked Items Which items have been locked by another user and 
who locked it. 

Workflow State The workflow state of the item. 

Broken Links Which items contains broken links. 

Missing Versions Which items are missing a version. 

Published Warnings Which items have published warnings 

Validation Rules Which items contain validation errors. 

Note 
The items that are available in this menu in your Sitecore solution may vary from the ones shown 
here. This is controlled by your Sitecore system administrator. 

You can select as many of these options as you like. There is a performance overhead to pay for 
each of these options. 

Important 
The Validation Rules and Broken Links options are the most costly of the Quick Action Bar options. 
Each time you open an item in the content tree the client must make a server call to refresh these 
options.  
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8.2.3 Changing the Application Options 

When you are using the Content Editor, you can also specify which elements of the Content Editor 
application should be displayed. 

To configure the Content Editor: 

1. In the Content Editor, click on the Sitecore button in the top left-hand corner. 

 

Alternatively, in the Sitecore Desktop, click the Sitecore menu and then click Control Panel, 
Preferences. 

2.  Click Application Options to open the Application Options dialog box. 

 

3. Select or clear any of the check boxes to hide or show the element in question. 
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The following screenshot points out where most of these elements are found in the Content Editor: 

 

The remaining elements in the Show/Hide section are: 

 Fields from Standard Template — selecting this option will display a large number of fields 
that are used internally by Sitecore. These are hidden to improve performance. 

 Use Smart Tags — an alternate way to show the commands associated with a field. 

 

 Prefetch Collapsed Sections — the system fetches and keeps the fields from the Field 
Sections in memory before the section is even opened. 

The other important option on the Content Editor tab is in the Pages section — Show Pages Bar. 

This option determines whether or not the shortcuts to the Sitecore applications are displayed at the 
bottom of the screen. 
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The View tab of the Application Options dialog box contains a few more options. 

 

In the Content Tree – Item Names section, you can specify whether you want the content tree to 
show the key that each item has or to show the language specific display name that you can give an 
item. 

In the Content Tree Root section, you can specify whether or not you want the content tree shown in 
the Content Editor and whether or not you want the entire content tree shown. 

Setting the Display Name of an Item 

To set the display name of an item: 

1. In the Content Editor, select the item in the content tree. 

2. On the Home tab, in the Rename section, click Display Name. 

3. When you are prompted, enter the name that you want displayed in the dialog box that 
appears. 

4. Refresh the content tree and the display name is visible: 

 

In the Content pane, the key is shown after the display name. 

Furthermore, the display name is also used for the item in the published Web site. 
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8.3 Customizing the Page Editor 

You can also customize the Page Editor. However, because the Page Editor contains limited 
functionality there is not that much that you can change about it. 

8.3.1 Working with the Ribbon 

The functionality that is available to you in the Page Editor is determined by the roles that your site 
administrator has assigned you. 

Hiding the Ribbon 

If you only have limited access to the functionality contained in the Page Editor, you can hide the 
ribbon to give yourself more space to work with. 

To hide the ribbon: 

1. Log in to the Page Editor. 

 

2. Click the Ribbon button at the top of the screen to hide the ribbon. 

3. When you need to use the ribbon, click Ribbon and it appears again. 

Changing the Interface 

If you have access to more functionality in the Page Editor, you can also change the way the Page 
Editor presents editable items to you. 

To change the interface: 

1. Log in to the Page Editor. 
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2. In the Page Editor, click the View tab. 

 

3. In the View tab, select or clear the check boxes to: 

o Specify whether or not the items are editable. 

o Whether or not the editable items are displayed in a floating frame. 

o Whether or not a dot is displayed beside the editable items. 
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